Caption Pro for Mac User Manual

Caption Pro for Mac User Manual
Version 3.2, September 2021
Table of Contents
Overview of Caption Pro for Mac Capabilities....................................................................................2
Installation, Running and Uninstallation..............................................................................................3
First Run and Upgrades...................................................................................................................3
Transferring Licenses and Upgrading..............................................................................................4
Operating Caption Pro for Mac............................................................................................................5
Importing Photos from External Devices........................................................................................6
Loading Files from Disc..................................................................................................................6
Loading Files from a Scanner..........................................................................................................7
Working with Multiple Input Files..................................................................................................7
Batch Processing Multiple Files.................................................................................................8
Sorting Multiple Files.................................................................................................................9
Entering and Applying Caption and Sub-caption Text..................................................................10
Quick Captioning with Multiple Files...........................................................................................10
Output Files....................................................................................................................................10
Presentations..................................................................................................................................13
Preferences.....................................................................................................................................13
Buttons...........................................................................................................................................16
Menu Items....................................................................................................................................17
Appendix............................................................................................................................................19
File Metadata Storage....................................................................................................................19

Commercial-in-Confidence

1

Aleka Consulting

Caption Pro for Mac User Manual

Overview of Caption Pro for Mac Capabilities
1. Load single or multiple JPEG images by browsing filesystem, using a scanner or by
drag/dropping files or folders onto application. Scans of multiple paper photos can be
automatically split into separate images.
2. Sort multiple files by modified date, date taken, file name or file path
3. Change modified date or date taken for files.
4. Remove files from input selection
5. View file metadata
6. Rotate input images before captioning
7. Manually add caption and/or sub-caption text in a caption bar located below a JPEG image
occupying a specified percentage of the original image height. Captions can be typed or
created from dictation.
1. Caption and sub-caption font and colour, and caption bar background colour are
selectable.
2. Caption is displayed a continuous, centred text, with font sized to fit text into the caption
bar. Sub-caption is displayed as multi-line text with font size scaled to fit image width.
8. Automatically create captions and/or subcaptions for multiple files from file metadata or
using specified text.
9. Remove or edit captions and/or sub-captions applied by Caption Pro for Mac.
10. Store captioned images by overwriting original files or creating new files in original image
folder or in a specified folder
11. Display loaded images as a slideshow
12. View images in full-screen mode
Caption Pro for Mac will work on Mac operating systems newer than 10.9 (Maverick), but scanner
access only works for MacOS 10.13 or newer. Caption Pro for Mac was developed in MacOS 10.15
(Catalina).
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Installation, Running and Uninstallation
Caption Pro for Mac can be downloaded from the Aleka Consulting web site as a .dmg file by
clicking here. After double-clicking on it, it will offer to move itself to the Applications folder as
shown bleo

The application will then appear in the Applications folder and the icon will appear in the
LaunchPad screen

The application can then be started by double-clicking on it in Finder or by clicking on the
LaunchPad icon like any other to show the Start screen as it appears in Figure 1.
To uninstall Caption Pro for Mac, drag the icon to the Bin icon at the bottom left of the screen.

First Run and Upgrades
A Demo license, valid for 30 days or 25 captions applied is created the first time Caption Pro for
Web is run. Saving a split created from a multi-photo image with ImageSplit consumes one of the
available captions. Uninstalling and re-installing will not generate a new Demo license. When this
license expires, files cannot be loaded. An operating license can be purchased by clicking the
License icon in the application window or License→ License.. in the menu bar and selecting Buy
License. An operating license is valid indefinitely for a particular Caption Pro for Web version and
major upgrades can be installed and licensed for 1 year after license purchase. Minor upgrades
(where the first two parts of the upgrade string do not differ from the licensed version) may be
installed indefinitely. Parts of the version string are separated by periods (.).
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Any changes to Preferences will have to be re-applied after an upgrade. After the license period
expires, any newer major version installed will not be licensed. License keys can be used on a
maximum of 2 CPUs.

Transferring Licenses and Upgrading
If a computer with a licensed version of Caption Pro for Mac installed is replaced, the license key
must be re-entered. If the license key is not available, or more than 1 replacement has occurred,
contact Aleka Consulting.
If a new version of Caption Pro for Mac is installed to replace an existing installation on a
computer, any existing license key will be automatically transferred.
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Operating Caption Pro for Mac
After starting Caption Pro for Mac for the first time, the following application screen will appear:

Figure 1: Caption Pro for Mac startup screen
Actions re available as toolbar buttons at the top of the application window, as well as via the menu
at the top of the screen..
Like most Mac applications, the application window is separate from the main menu, which is
shown below:
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Importing Photos from External Devices
Connecting an iPhone to a Mac allows the iPhone (including photos) content to be backed up on the
Mac via Finder. Photos are automatically visible in the Photos Library or albums, but they must be
exported to disc to be visible to Caption Pro for Mac. If the external device has a removable SD
card, these can be plugged in directly and the content accessed.
Android devices connecting via a USB cable are not detected by Macs unless the free application
Android File Transfer is installed. This application displays the content of an Android device as a
folder tree but cannot open any files displayed. Files shown by Android File Transfer must be
dragged and dropped into a Mac folder to be opened. Files cannot be copied from the application
via ⌘-C. Files can also be transferred from a Mac to an Android device in the same way.

Loading Files from Disc
One or more files can be loaded from disc by clicking the Load File(s) toolbar button or selecting
from the File menu. Single or multiple files can then be selected. Files and folder content can also
also be selected by dragging and dropping onto the application window. Files loaded by drag and
drop are added to those already shown in the file list. Load from Folder.. allows selection of all
JPEG files in a selected folder or the selected folder and subfolders. Note that when a folder is
selected, all the files within the browse screen are greyed out and only subfolders are selectable, but
the Open button at the bottom right is highlighted in blue as shown below:

After loading multiple files, the first file in the list is selected and highlighted in blue, with the
image displayed.
Although multiple selections can be made (by holding cmd while selecting individual files or
selecting a range by files by clicking one file and shift-clicking another), captions can only be added
when a single file is selected. Files are listed in the left-hand area of the screen, with the first one
selected as shown below. Multiple file ordering can be set in the Preferences screen or by clicking
the Change.. button above the file list
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Figure 2: Screen after loading multiple files
The pixel size and orientation and file size for the selected file is shown beneath the file list,
together with the file modified date and the date on which the image was taken with the GPS
location data if either are present. The full path to the selected file is shown at the top of the screen.
The license status is shown at the bottom of the screen. A Demo license is generated by default if
none is supplied.

Loading Files from a Scanner
The ImageSplit toolbar item allows Caption Pro for Mac to access scanners accessible to the Mac,
and to apply auto-detection of multiple photos placed on the scanner bed. This process is described
in more detail in the ImageSplit documentation.

Working with Multiple Input Files
After loading multiple files and/or folders, either by selecting via the File menu options, the toolbar
buttons, or by drag and drop from Finder, the file list is shown with the first item in the list
selected. If folders are selected, files within sub-folders may optionally be included. Clicking the
up or left arrow keys moves the selected file up and clicking the down or right arrow keys moves
the selection down, provided that a file is highlighted in blue. Note that if the cursor is in the
caption or sub-caption box, the file selection is highlighted in grey and the arrow keys have no
effect.
Files can be removed from the file list by highlighted them and clicking the Remove button or the
Edit→ Remove from List option. An individual selection can be added to by command-clicking on
further files. A range of files can be selected by clicking on one item and shift-clicking on another.
All files, including those clicked, will then be selected.
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Batch Processing Multiple Files
Captions and subcaptions can be generated automatically using the Start Batch option available in
the toolbar, which is enabled whenever one or more files is loaded:

Clicking Start Batch allows processing of all of the loaded images, or a selection of them as shown
below, using the parameters defined in the Batch Options tab of the Preferences Screen:

The Batch Options tab provides a number of options for defining the source of caption and
subcaption text as shown below:

Figure 3: Batch Processing Options for Data
Sources
If None is selected as the data source, no data is added. Fixed text allows the addition of the same
text to all the processed files. An example of its use might be to caption multiple files as “Italy
Holiday 2011”. Date allows a date, obtained either from the file Modified date or the date on which
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the image was created, in formats selectable from three options. The image creation date may not
exist for some images, such as those obtained by scanning paper photos. In this case no caption or
sub-caption will be created. File and folder names may also be used as data sources, and any Title or
Caption/Abstract text in IPTC metadata, which may be created using Photoshop, Picasa or other
programs. Note that the IPTC Title field has the name ObjectName internally. If this data is not
present no caption or sub-caption data is set.

Sorting Multiple Files
The order in which loaded files are listed is shown above the file list and can be changed using the
Change.. button or in via Preferences. Options are shown below:

Ordering by Path includes the folder containing the file in the string to be sorted. Date taken is the
EXIF Date Time Original metadata field. This field is absent in images not taken from a digital
camera, such as images from a scanner. Date metadata can be set for an image via the Set Dates..
button to the right of the date data. Clicking Set Dates.. shows the following screen:

If the Date Taken field is missing, a default date/time as shown above is shown. Any part of the date
string can be changed by selecting it and clicking the up or down arrow keys. If New File is
checked, the file with changed dates is created as a new file either in the original file folder or in a
different folder as specified in Preferences. If it is not checked, the selected file has its dates
modified. Setting Date Taken also sets the IPTC metadata fields Date Created and Time Created.
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Viewing Metadata
Clicking the Metadata toolbar button (enabled if just one file is selected) shows image file metadata
from the EXIF, GPS, IPTC and TIFF groups as shown below:

Figure 4: Metadata from a captioned iPhone
camera image
Where a metadata field has multiple values (such as Exif Lens specification), individual values are
enclosed in braces. Where a field contains multiple lines (such as Exif-UserComment) lines are
separated by the string “ ^ “. Fields used by Caption Pro for Mac have their role added in brackets
after the field name. They are Exif-CameraOwnerName (Sub-caption), Exif-UserComment
(Caption display parameters) and IPTC-CaptionAbstract(Caption). Changing any of these fields in
other programs will affect the ability of Caption Pro for Mac to edited captioned images.
Metadata may be much less extensive or not present all for some images before captioning s

Entering and Applying Caption and Sub-caption Text
A caption and/or sub-caption can be defined by entering text into the appropriate text box, or by
clicking in the required box and selecting Edit→ Start Dictation and speaking the required text. The
percentage of the original height used by the caption and sub-caption is shown in the dropdown
boxes beneath the Height (%) label. Caption/sub-caption text is applied with the Apply button and
can be removed with the Remove button. Captions can also be applied by clicking return in the
Caption box.
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The caption text is displayed as continuous text, centred to fit into the area defined by the image
width and the selected caption height. For the multi-line sub-caption, the alignment can be either
left or centre according the radio button to the right of the box. Sub-caption size is set to fit the
longest line into the image width, as shown in Figure 7

Quick Captioning with Multiple Files
Holding the shift key when clicking the Apply button or the return key with the cursor in the caption
box will apply the caption and/or sub-caption and display the next image in the list, retaining
caption and/or sub-caption text entered for the first file.

Output Files
The output file folder and file name depend on Preferences settings. If Overwrite Existing File is
selected, the file name will be the same as the input file, in the input file folder if Original Folder is
selected and in the specified Different Folder if that option is selected. Any existing file in that path
is overwritten. If Overwrite Existing File is not checked, a bracketed sequence number will be
added before the file extension. The default Different Folder is Pictures/Captioned. If the
Preferences option for File Name Display is Update When Captioned, the list entry for the file
being captioned will be replaced by the output file name, allowing the captioned files in the list to
be viewed using the left or right arrow keys. If the default option of using a different folder for the
captioned files is selected, with any existing file being overwritten, the file name will not change,
but the file height will increase and the orientation will be normal, irrespective of the input file
orientation. The Output tab of the Preferences screen is shown below:

Figure 5: Output tab of Preferences Screen
If the File Name Display is set to Input Only, the file list entry will show the input file only, and
using the arrow keys to move through the file list will not show any captions unless the Original
Folder and Overwrite Existing options are selected. The figure below compares the display after
adding a caption to Portrait_2.jpg using Update When Captioned (top) with Input Only (bottom).
User Original Folder is checked and Overwrite Original is unchecked in both cases. Note that the
path to the captioned file is shown above the image.
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Figure 6: Comparison of Update after Captioning (top) and Input Only
modes (bottom)
An example of a full display is shown below:

Figure 7: Image with caption and left-aligned multi-line sub-caption applied
The default location for captioned images is in the user Pictures\Captioned, as specified in the
Caption Pro for Mac →Preferences screen as detailed in the following section. The captioned file
path is shown above the captioned image. Note that the selected item from the list is highlighted in
blue if the list control has the focus, and in grey otherwise.
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Presentations
Caption Pro for Mac can be used for displaying an ordered series of images either automatically
(via the Slideshow option) or manually by selecting the Full Screen option and clicking the forward
or back buttons. A common scenario for ceremonial occasions such as birthdays or funerals is to
display a set of images, sometimes including scanned and born-digital images. To achieve the
desired ordering, the Modified or Date Taken metadata may need to be set for some images.
If a more sophisticated presentation is required, captioned images can be imported into the Mac
Photos application as an album, and the album used to create a Slideshow project via My Projects.
These slideshows can incorporate background music and a range of transition effects.

Preferences
Preferences for captioned image location, font type, colour and background colour, slideshow and
batch processing parameters are set in the Preferences screen, accessed via the Caption Pro for
Mac→ Preferences menu item as shown below:

Figure 8: Output tab of Preferences Screen
Captioned output can be saved in the original folder (containing the input file) or a different folder.
The default is to use a different folder as shown above. If Overwrite Existing File is checked, any
existing file with same file path is overwritten by the captioned file. If it is unchecked, a sequence
number is added before the file extension for each captioning action. If File Name Display is set to
Update When Captioned, the file list entry is updated to show the captioned file name and the arrow
keys can be used to display the captioned files. Note that the file name of the captioned file will be
the same if there is no existing file at the path. If File Name Display is set to Input Only, only input
file names are shown in the list, and the arrow keys will display only the input files.
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The sort order for multiple files is shown in the File Ordering area.
Font types, colours and background colour can be set on the Fonts and Colours tab:

Figure 9: Fonts and Colours Tab of Preferences Screen
The font family is set in the top combo box, and the family member by the lower one. An example
of how the caption will appear is shown in the bottom left. Font colour and the colour of the
background can be set by the respective buttons. The Set Default Font & colours sets the font to
Helvetica, the background colour to white and the font colour to black.
Slideshow options are set in the Slideshow tab:

If full screen mode is being used command-S will toggle slideshow operation. Clicking Escape will
stop the slideshow. The Preferences Slideshow Stops at End checkbox controls whether the
slideshow loops back to the start after reaching the end, and the Slideshow Speed setting determines
how long each slide is shown for.
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The Batch Options tab provides a number of options for defining the source of caption and
subcaption text as shown below:

Figure 10: Batch Processing Options for Data Sources
If None is selected as the data source, no data is added. Fixed text allows the addition of the same
text to all the processed files. An example of its use might be to caption multiple files as “Italy
Holiday 2011”. Date allows a date, obtained either from the file Modified date or the date on which
the image was created, in formats selectable from three options. The image creation date may not
exist for some images, such as those obtained by scanning paper photos. In this case no caption or
sub-caption will be created. File and folder names may also be used as data sources, and any Title or
Caption/Abstract text in IPTC metadata, which may be created using Photoshop, Picasa or other
programs. Note that the IPTC Title field has the name ObjectName internally. If this data is not
present no caption or sub-caption data is set.
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Toolbar Buttons
Common operations can be performed using the labelled buttons at the top of the application screen
as shown below:

Button Label
Load Files..
Load From Folder..
Metadata
ImageSplit
License
Full Screen
Slideshow

Rotate Left
Rotate Right
Remove
Start Batch
Stop Batch
License
Move to Trash

Action
Load JPEG files selected from a browse screen
Load JPEG files contained in a folder or a folder and sub-folders
Show selected file metadata
Show scanner interface for splitting scans of multiple photos
Enter License key
Display only the image using as much of the screen as possible. Useful for
slideshows. Click esc to leave full screen mode. The right and left arrow
keys can be used to move between slides.
Start or stop a slideshow. If full screen mode is being used command-S will
toggle slideshow operation. Clicking Escape will stop the slideshow. The
Preferences Slideshow Stops at End checkbox controls whether the
slideshow loops back to the start after reaching the end, and the Speed
setting determines how long each slide is shown for.
Rotates the image 90 degrees to the left. Needed if image rotation flag is
missing or incorrect.
Rotates the image 90 degrees to the right. Needed if image rotation flag is
missing or incorrect.
Remove selected items from the file list.
Start batch processing using settings defined in Preferences→ Batch
Settings
Stop batch processing
Shows the license entry screen.
Removes selected items from the file list and places them in Trash.
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Menu Items
Caption Pro for Mac Menu items are as follows:
Top Level Item
Caption Pro for
Mac

Item
About Caption Pro
for Mac
Check for Updates
Preferences..
Services

File

Edit
(only enabled
when caption or
sub-caption has
focus)

Hide CaptionPro
for Mac
Hide Others
Show All
Quit Caption Pro
for Mac
Load File(s)..
Load File(s) in
Folder..
View Metadata
ImageSplit
Close
Paste
Copy

Action
Display credits
Not implemented
Show screen to select modes of operation and operation
parameters
Show other diagnostic programs – of interest only to
developers
Hide the application
Hide all other application windows
Show all application windows
Close application
Browse for JPEG files to load
Browse for folders containing JPEG files to load
Show metadata for selected file
Show Scanner Interface
Close the application
Paste clipboard text into caption or sub-caption boxes
Copy text from caption or sub-caption boxes

Cut
Start Dictation
Emoji & Symbols
Window

Cut text from caption or sub-caption boxes
Enable creation of captions or sub-captions from speech
Show selection of emojis and symbols. Selection adds to
caption or sub-caption.
Minimize
Minimize the application window
Zoom
Resize the application window to fill the display
Tile Window to Left Show all running application windows as separate tiles,
of Screen
with the application window on the left.
Tile Window to
Show all running application windows as separate tiles,
Right of Screen
with the application window on the right
Start Slideshow!
Start running the slideshow
Enter Fullscreen
Show only the image at the maximum possible size
Exit Fullscreen
Leave full screen mode (esc button is the keyboard
shortcut)
Toggle Fullscreen Toggle full screen mode (option-command-F)
Bring All to Front No effect
Last Item
Window Title – initially No File Loaded, after caption
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Image

Rotate Left
Rotate Right
Reveal in Finder
Remove from List
Move to Trash

License
Help

License
Search
ImageSplit User
Manual
Caption Pro User
Manual
Support
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applied, path to displayed file
Rotate image 90 degrees to the left
Rotate image 90 degrees to the right
Show image selected from list in Finder
Remove select items from list
Remove select items from list and move files to Trash
folder
Show License purchase and entry screen
Search the menu items
Show the ImageSplit user manual (as PDF file) – can be
printed
Show the Caption Pro for Mac user manual (as PDF file) –
can be printed
Find and mail support log file, contact Aleka Consulting
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Appendix
File Metadata Storage
Caption Pro uses the following metadata fields for storage in order to allow editing of applied
caption text:
Metadata Group Field Name
EXIF
UserComment

Use
Storage of image height before captioning, caption and
subcaption height as percentage, sub-caption alignment
CameraOwnerNameSub-caption text (including line breaks)
IPTC
CaptionAbstract or Caption text
Caption/Description
If data is present in either EXIF/CameraOwnerName or IPTC/CaptionAbstract it will be shown in
the respective fields when the file is loaded.
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